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CTRL combination shortcut keys 

KEY DESCRIPTION 

CTRL+SHIFT+( Unhides any hidden rows within the selection. 

CTRL+SHIFT+) Unhides any hidden columns within the selection. 

CTRL+SHIFT+& Applies the outline border to the selected cells. 

CTRL+SHIFT_ Removes the outline border from the selected cells. 

CTRL+SHIFT+~ Applies the General number format. 

CTRL+SHIFT+$ Applies the Currency format with two decimal places (negative numbers in parentheses). 

CTRL+SHIFT+% Applies the Percentage format with no decimal places. 

CTRL+SHIFT+^ Applies the Exponential number format with two decimal places. 

CTRL+SHIFT+# Applies the Date format with the day, month, and year. 

CTRL+SHIFT+@ Applies the Time format with the hour and minute, and AM or PM. 

CTRL+SHIFT+! Applies the Number format with two decimal places, thousands separator, and minus sign (-) for 
negative values. 

CTRL+SHIFT+* Selects the current region around the active cell (the data area enclosed by blank rows and blank 

columns). 

In a PivotTable, it selects the entire PivotTable report. 

CTRL+SHIFT+: Enters the current time. 

CTRL+SHIFT+" Copies the value from the cell above the active cell into the cell or the Formula Bar. 

CTRL+SHIFT+Plus 
(+) 

Displays the Insert dialogue box to insert blank cells. 

CTRL+Minus (-) Displays the Delete dialogue box to delete the selected cells. 

CTRL+; Enters the current date. 

CTRL+` Alternates between displaying cell values and displaying formulas in the worksheet. 

CTRL+' Copies a formula from the cell above the active cell into the cell or the Formula Bar. 

CTRL+1 Displays the Format Cells dialogue box. 

CTRL+2 Applies or removes bold formatting. 

CTRL+3 Applies or removes italic formatting. 

CTRL+4 Applies or removes underlining. 

CTRL+5 Applies or removes strikethrough. 

CTRL+6 Alternates between hiding objects, displaying objects, and displaying placeholders for objects. 

  

CTRL+8 Displays or hides the outline symbols. 

CTRL+9 Hides the selected rows. 

CTRL+0 Hides the selected columns. 

CTRL+A Selects the entire worksheet.  

If the worksheet contains data, CTRL+A selects the current region. Pressing CTRL+A a second time 

selects the current region and its summary rows. Pressing CTRL+A a third time selects the entire 

worksheet. 

When the insertion point is to the right of a function name in a formula, displays the Function 

Arguments dialogue box. 

CTRL+SHIFT+A inserts the argument names and parentheses when the insertion point is to the right of 

a function name in a formula. 

CTRL+B Applies or removes bold formatting. 

CTRL+C Copies the selected cells.  

CTRL+C followed by another CTRL+C displays the Clipboard. 

CTRL+D Uses the Fill Down command to copy the contents and format of the topmost cell of a selected range 
into the cells below. 

Quick reference: Excel 2010 shortcuts 
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CTRL+F Displays the Find and Replace dialogue box, with the Find tab selected.  

SHIFT+F5 also displays this tab, while SHIFT+F4 repeats the last Find action. 

CTRL+SHIFT+F opens the Format Cells dialogue box with the Font tab selected. 

CTRL+G  Displays the Go To dialogue box.  

F5 also displays this dialogue box. 

CTRL+H  Displays the Find and Replace dialogue box, with the Replace tab selected. 

CTRL+I Applies or removes italic formatting. 

CTRL+K Displays the Insert Hyperlink dialogue box for new hyperlinks or the Edit Hyperlink dialogue box for 
selected existing hyperlinks. 

CTRL+N  Creates a new, blank workbook. 

CTRL+O  Displays the Open dialogue box to open or find a file. 

CTRL+SHIFT+O selects all cells that contain comments. 

CTRL+P Displays the Print dialogue box. 

CTRL+SHIFT+P opens the Format Cells dialogue box with the Font tab selected. 

CTRL+R Uses the Fill Right command to copy the contents and format of the leftmost cell of a selected range 
into the cells to the right. 

CTRL+S Saves the active file with its current file name, location, and file format. 

CTRL+T Displays the Create Table dialogue box. 

CTRL+U Applies or removes underlining. 

CTRL+SHIFT+U switches between expanding and collapsing of the formula bar.  

CTRL+V  Inserts the contents of the Clipboard at the insertion point and replaces any selection. Available only 

after you have cut or copied an object, text, or cell contents. 

CTRL+ALT+V displays the Paste Special dialogue box. Available only after you have cut or copied an 

object, text, or cell contents on a worksheet or in another program. 

CTRL+W Closes the selected workbook window. 

CTRL+X  Cuts the selected cells. 

CTRL+Y Repeats the last command or action, if possible. 

CTRL+Z Uses the Undo command to reverse the last command or to delete the last entry that you typed. 

CTRL+SHIFT+Z uses the Undo or Redo command to reverse or restore the last automatic correction 

when AutoCorrect Smart Tags are displayed. 

 

Function keys 

KEY DESCRIPTION 

F1 Displays the Microsoft Office Excel Help task pane. 

CTRL+F1 displays or hides the Ribbon, a component of the Microsoft Office Fluent user interface. 

ALT+F1 creates a chart of the data in the current range. 

ALT+SHIFT+F1 inserts a new worksheet. 

F2 Edits the active cell and positions the insertion point at the end of the cell contents. It also moves the insertion point 

into the Formula Bar when editing in a cell is turned off. 

SHIFT+F2 adds or edits a cell comment. 

CTRL+F2 displays the Print Preview window. 

F3 Displays the Paste Name dialogue box. 

SHIFT+F3 displays the Insert Function dialogue box. 

F4 Repeats the last command or action, if possible. 

CTRL+F4 closes the selected workbook window. 

F5 Displays the Go To dialogue box. 

CTRL+F5 restores the window size of the selected workbook window. 

F6 Switches between the worksheet, Ribbon, task pane, and Zoom controls. In a worksheet that has been split (View 

menu, Manage This Window, Freeze Panes, Split Window command), F6 includes the split panes when switching 

between panes and the Ribbon area.  

SHIFT+F6 switches between the worksheet, Zoom controls, task pane, and Ribbon. 

CTRL+F6 switches to the next workbook window when more than one workbook window is open. 
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F7 Displays the Spelling dialogue box to check spelling in the active worksheet or selected range. 

CTRL+F7 performs the Move command on the workbook window when it is not maximized. Use the arrow keys to 

move the window, and when finished press ENTER, or ESC to cancel. 

F8 Turns extend mode on or off. In extend mode, Extended Selection appears in the status line, and the arrow keys 

extend the selection. 

SHIFT+F8 enables you to add a nonadjacent cell or range to a selection of cells by using the arrow keys. 

CTRL+F8 performs the Size command (on the Control menu for the workbook window) when a workbook is not 

maximized. 

ALT+F8 displays the Macro dialogue box to create, run, edit, or delete a macro. 

F9 Calculates all worksheets in all open workbooks. 

SHIFT+F9 calculates the active worksheet. 

CTRL+ALT+F9 calculates all worksheets in all open workbooks, regardless of whether they have changed since the 

last calculation. 

CTRL+ALT+SHIFT+F9 rechecks dependent formulas, and then calculates all cells in all open workbooks, including 

cells not marked as needing to be calculated. 

CTRL+F9 minimizes a workbook window to an icon. 

F10 Turns key tips on or off. 

SHIFT+F10 displays the shortcut menu for a selected item. 

ALT+SHIFT+F10 displays the menu or message for a smart tag. If more than one smart tag is present, it switches to 

the next smart tag and displays its menu or message. 

CTRL+F10 maximizes or restores the selected workbook window. 

F11 Creates a chart of the data in the current range. 

SHIFT+F11 inserts a new worksheet. 

ALT+F11 opens the Microsoft Visual Basic Editor, in which you can create a macro by using Visual Basic for 

Applications (VBA). 

F12 Displays the Save As dialogue box. 

 

Other useful shortcut keys 

KEY DESCRIPTION 

ARROW 
KEYS 

Move one cell up, down, left, or right in a worksheet.  

CTRL+ARROW KEY moves to the edge of the current data region in a worksheet. 

SHIFT+ARROW KEY extends the selection of cells by one cell. 

CTRL+SHIFT+ARROW KEY extends the selection of cells to the last nonblank cell in the same column or row 

as the active cell, or if the next cell is blank, extends the selection to the next nonblank cell. 

LEFT ARROW or RIGHT ARROW selects the tab to the left or right when the Ribbon is selected. When a 

submenu is open or selected, these arrow keys switch between the main menu and the submenu. When a 

Ribbon tab is selected, these keys navigate the tab buttons. 

DOWN ARROW or UP ARROW selects the next or previous command when a menu or submenu is open. 

When a Ribbon tab is selected, these keys navigate up or down the tab group. 

In a dialogue box, arrow keys move between options in an open drop-down list, or between options in a group 

of options. 

DOWN ARROW or ALT+DOWN ARROW opens a selected drop-down list. 

BACKSPACE Deletes one character to the left in the Formula Bar. 

Also clears the content of the active cell. 

In cell editing mode, it deletes the character to the left of the insertion point. 

DELETE Removes the cell contents (data and formulas) from selected cells without affecting cell formats or comments.  

In cell editing mode, it deletes the character to the right of the insertion point.  

END Moves to the cell in the lower-right corner of the window when SCROLL LOCK is turned on. 

Also selects the last command on the menu when a menu or submenu is visible. 

CTRL+END moves to the last cell on a worksheet, in the lowest used row of the rightmost used column. If the 

cursor is in the formula bar, CTRL+END moves the cursor to the end of the text.  

CTRL+SHIFT+END extends the selection of cells to the last used cell on the worksheet (lower-right corner). If 

the cursor is in the formula bar, CTRL+SHIFT+END selects all text in the formula bar from the cursor position 

to the end—this does not affect the height of the formula bar.  

ENTER Completes a cell entry from the cell or the Formula Bar, and selects the cell below (by default). 

In a data form, it moves to the first field in the next record. 

Opens a selected menu (press F10 to activate the menu bar) or performs the action for a selected command. 
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In a dialogue box, it performs the action for the default command button in the dialogue box (the button with 

the bold outline, often the OK button). 

ALT+ENTER starts a new line in the same cell. 

CTRL+ENTER fills the selected cell range with the current entry. 

SHIFT+ENTER completes a cell entry and selects the cell above. 

ESC Cancels an entry in the cell or Formula Bar.  

Closes an open menu or submenu, dialogue box, or message window. 

It also closes full screen mode when this mode has been applied, and returns to normal screen mode to 

display the Ribbon and status bar again. 

HOME Moves to the beginning of a row in a worksheet. 

Moves to the cell in the upper-left corner of the window when SCROLL LOCK is turned on. 

Selects the first command on the menu when a menu or submenu is visible. 

CTRL+HOME moves to the beginning of a worksheet. 

CTRL+SHIFT+HOME extends the selection of cells to the beginning of the worksheet. 

PAGE DOWN Moves one screen down in a worksheet.  

ALT+PAGE DOWN moves one screen to the right in a worksheet. 

CTRL+PAGE DOWN moves to the next sheet in a workbook. 

CTRL+SHIFT+PAGE DOWN selects the current and next sheet in a workbook. 

PAGE UP Moves one screen up in a worksheet. 

ALT+PAGE UP moves one screen to the left in a worksheet. 

CTRL+PAGE UP moves to the previous sheet in a workbook. 

CTRL+SHIFT+PAGE UP selects the current and previous sheet in a workbook. 

SPACEBAR In a dialogue box, performs the action for the selected button, or selects or clears a check box. 

CTRL+SPACEBAR selects an entire column in a worksheet. 

SHIFT+SPACEBAR selects an entire row in a worksheet. 

CTRL+SHIFT+SPACEBAR selects the entire worksheet.  

 If the worksheet contains data, CTRL+SHIFT+SPACEBAR selects the current region. Pressing 
CTRL+SHIFT+SPACEBAR a second time selects the current region and its summary rows. Pressing 
CTRL+SHIFT+SPACEBAR a third time selects the entire worksheet.  

 When an object is selected, CTRL+SHIFT+SPACEBAR selects all objects on a worksheet. 

ALT+SPACEBAR displays the Control menu for the Microsoft Office Excel window. 

TAB Moves one cell to the right in a worksheet. 

Moves between unlocked cells in a protected worksheet. 

Moves to the next option or option group in a dialogue box. 

SHIFT+TAB moves to the previous cell in a worksheet or the previous option in a dialogue box. 

CTRL+TAB switches to the next tab in dialogue box. 

CTRL+SHIFT+TAB switches to the previous tab in a dialogue box. 
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Unit 1: Getting Started 
 
In this section you will learn: 
 

� What Microsoft Excel 2010 is 
� How to open Microsoft Excel 
� How to interact with Excel 
� How to close Excel 
� How to create a new workbook 
� How to open a workbook 
� How to close a workbook 
� About the active cell 
� How to select cells 
� How to use the Help screen 

 
 
 

 Opening Microsoft Excel 
There are a number of ways to open the Excel 2010 program. First, look for the Excel 2010 icon 

on your desktop (  ) and double click it. The Excel 2010 screen should open for you. 
 
If you cannot find the Excel 2010 icon, click the Start button on the bottom left corner of your 
desktop to display the Start menu; then choose: 
 
Programs/All Programs � Microsoft Office � Microsoft Office Excel 2010 
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Interacting with Excel 
Once you open Excel 2010, you should see an Excel screen (also called a user interface) like 
the one shown below. 
 

 
 

Columns, Rows, Cells, and Ranges 
Columns, rows, and cells are the most fundamental components of a work sheet. 
A column is a vertical series of adjacent cells from top to bottom. A row is a horizontal series of 
cells from left to right. A cell is an individual rectangle anywhere in the grid area of a worksheet. 
 

 
 

Name Box Quick Access Toolbar 

Formula Bar 

Ribbon Tabs 

Sheet Tabs Status Bar 

Excel Title Bar 
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The Active Cell 
Every cell in your spreadsheet has a name or reference that can be formed by a letter-number 
combination, e.g. A5, D6.  
 
When you select a cell in an Excel worksheet, it becomes enhanced with a thicker border. The 
cell you have chosen is now the active cell, and its name or reference is the cell column letter 
followed by the cell row number. In this image, cell G4 is the active cell. 
 

 
 

 
The column letter and row number of the active cell are displayed in the Name Box near the 
upper left corner of the Excel grid.  
 
If you enter text or numbers into the Formula Bar (shown below), the text or number that you 
type will also be entered into the active cell.  
 

 
 

Selecting Cells 
To select a group of cells, place your mouse pointer in the centre of a cell. When the pointer 
turns into a thick white shaded cross, hold the left mouse button down and drag the pointer 
across the row or down the column of cells you want to select. In this image, the cells B1 to B4 
have been selected. 
 

 
 

The active cell 
is G4 
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The Ribbon 
This part of the Excel interface is what allows you to control, format, and edit the data stored in 
the Excel grid area of the spreadsheet. This is also where the tools that help you analyse, 
interpret, organise, and present your data are found. Each ribbon is separated into groups with 
the group name shown at the bottom. Each group contains buttons which can be used as tools 
to performing functions, e.g. in the 'Home' ribbon below, examine the 'Font' group. Use these 
buttons to change some types of formatting of the contents of a cell. 
 

If you left click one of the labeled tabs above the Ribbon (Home, Insert, Page Layout, Formulas, 
Data, Review, View), you will see the buttons and controls in the Ribbon change according to 
the tab you click on. 
 
If you let your mouse pointer hover on a button or control, you will see a shaded box appear. 
This box, also known as a 'Screen Tip', will show you the name and a brief description of the 
button or control in question. 
 

 
Try it: View the different Ribbons available by clicking on each named tab above the Ribbon. 
Let your mouse pointer hover over the individual controls and buttons in a Ribbon to see 
information about them.  

 
The Quick Access Toolbar 

 
The Quick Access toolbar is located at the top left of the Excel window (to the right of the Excel 
Logo) and contains by default three buttons, namely, Save, Undo and Redo. The purpose of 
this toolbar is to provide you with quick access to buttons which may not be on any of the 
ribbons.  
 
There are three ways to add more buttons to the Quick Access toolbar: - 

1. Click the drop-down arrow on the right hand side of the Quick Access toolbar and select 
whichever buttons you desire to use. 

2. Right-click any button on one of the ribbons and click 'Add to Quick Access toolbar'. 
3. Click the drop-down arrow and select 'More Commands' 

a. Select a button from the left-hand panel and click 'Add' or double-click to place 
the button into the Customise Quick Access toolbar section. 

b. Buttons can be re-arranged by using the up/down arrows on the right 
 
The Quick Access toolbar can be shown above or below the ribbon. 



 

www.microsofttraining.net Tel: 0845 519 4797 Page 11 
© Best STL 2013  

The File Menu (Backstage) 
You can display the 'Backstage' menu by clicking File Tab on left of the screen.  

 
 
 
Try it: Click the File Tab to view the 'Backstage' menu items. 

 

Creating a New Workbook 
Once Excel is open, you can create additional new workbooks by clicking on the File Tab and 
clicking the 'New' button then click 'Create'. 

 
 
You can also create a new workbook by using the shortcut keys Ctrl + N. 
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Opening a Workbook 
To open a workbook, display the File > Backstage menu and either: 
� Choose Open or 
� Choose a workbook from the Recent Documents list. 
 

 
 

 
 
You can also use the shortcut keys Ctrl + O. 
 
Try it: Open the file Sales report.xlsx. 



 

www.microsofttraining.net Tel: 0845 519 4797 Page 13 
© Best STL 2013  

Closing a Workbook 
Closing a workbook is different from saving a workbook. If you have not made any changes to 
the workbook, just left click the lower X in the upper right corner of the workbook. 
 

 
 
Try it: Close the file Sales report.xlsx. 
 

Closing Excel 
To close Excel and all open Excel files, click the top X in the upper right corner of the Excel 
screen.  
 

 
 

 
Using the Help Screen 
If you find that you need help with a given topic in Excel 2010, you can access the Excel Help 
Screen by clicking on the question mark button in the upper right corner of the Excel screen.  
 

 
 

 
 
 
You can also display the Help Screen by pressing F1 on your keyboard. 

Help 

Close Excel program 

Close workbook 
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Unit 1 Practice Activity 
 
1. Start Excel. 

2. Open the file Practice employee information.xlsx 

3. Try using the following keys to change the selection of the active cell: 

a. Right, down, left and up arrow keys 

b. Ctrl + right, Ctrl + down, Ctrl + left and Ctrl + up arrow keys 

c. Page Up and Page Down keys 

d. Ctrl + Page Down, Ctrl + Page Up 

e. Ctrl + End, Ctrl + Home 

4. Use Excel Help to find information on Excel shortcut keys (Search for Key Tips) 

5. Close Help. 

6. Close Practice employee information but keep the Excel program open. 

 
 
 

Online support forum and knowledge base 
www.microsofttraining.net/forum 
Visit our forum to have your questions answered by our Microsoft certified trainers. 
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Unit 2: Entering and Editing Data 
 
In this section you will learn how to: 
 

� Create worksheet labels 
� Enter and delete data 
� Use the AutoFill feature 
� Use AutoComplete 
� Work with basic formulas 
� Save an Excel workbook 

 
 
 

Entering and Editing Data 
Now that you understand the basics of columns, rows, ranges, and labels, it is time to start 
working with data. One way to enter data into an Excel worksheet is to click on the cell you 
want to use (making it the active cell) and enter the information directly into it. When you type 
something in the active cell, what you type will also be displayed into the formula bar.  
 

 
 
 

 
If you type text, numbers, or formulas in the Formula Bar and press Enter, the data or formula 
you typed will be entered into the active cell. When you enter data in the formula bar, you will 
see an X and a check mark next to the data entry field. If you click the X (cancel), the data in 
the formula bar will be cleared. Clicking the check mark will enter the data just like pressing the 
Enter key. 
 

 

C2 is the 
active cell Formula Bar 
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Try it: Open Sales report.xlsx. On Sheet 1 enter details for Julian in row 7 as shown below.  

 
 
Handy hint: 
Values should be entered in without currency symbols or commas as these can be applied 
using number formats later on. 

Using Undo and Redo 
Anyone can make mistakes, especially when creating a complex worksheet. Excel provides a 
way of backtracking over, or undoing incorrect or unintended actions. 
  
To undo an action, click the Undo button on the Quick Access Toolbar. This will undo the very 
last action you performed. The shortcut combination of CTRL + Z performs the same action. 

 
 
If you want to redo an action (perform an action that you undid with Undo), you can click the 
Redo button on the quick access toolbar. 

 
 
You can also click the downward pointing triangle to show a list of recent actions. You can 
select actions from this list and then click the selected item to delete it and any other actions 
above it in the list. 

 
 

Try it: Using Sales report.xlsx, use Undo several times to reverse typing labels into row 7. 
Then use Redo to re-enter labels. 
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Editing labels and values 
There are various ways to edit (make changes to) labels and values that have been entered 
into a spreadsheet. 
 
The Formula Bar can be used to edit the contents of a cell. Select the cell to be edited, and 
click in the formula bar to edit. 

 
 
Try it: On Sheet 1 of the file Sales report.xlsx, use the formula bar to edit the cell A2 to read 
Sales report for the Central region. 
 
To edit directly inside a cell: 

� Double-click directly on the cell and use the arrow keys or click to move the cursor 
� Press the F2 key – the cursor appears at the right end of the cell contents 

 
Try it: In Sales report.xlsx, switch to Sheet 2. Edit the cell A2 to read Sales targets for the 
Central region. 
 
 

AutoFill and AutoComplete 
When working with spreadsheets, it is often the case that you must repeat data in a large 
number of cells. Excel helps you do this efficiently by automating some basic and repetitive 
tasks for you.  

Using AutoFill 
The Fill handle is a useful tool in Excel. Positioning your cursor over the bottom-right corner of 
the active cell brings the Fill handle up on your screen. 
 
 
 
 
 
The Fill handle can be used to quickly enter: 

� Quarters (Quarter 1, Quarter 2 etc). 
� Days of the week 
� Months of the year 

 
Try it: On Sheet 2 of the file Sales report.xlsx, type Qtr 1 into cell B4. 
Use the Fill handle to fill in Qtr 2, Qtr 3 and Qtr 4 from B4 through to E4 
Use the blank area under the spreadsheet on Sheet 2 to practice using the Fill handle to enter 
days of the week and months of the year. 
Type the first day or month (Monday or January), then use the Fill handle to enter in the 
following days or months. 

The Fill handle 
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What is AutoComplete? 
AutoComplete will help you enter data by completing what you type, based on similar data in 
adjacent cells in the same column. If you enter the name John in a cell, and then type the letter 
J in the cell immediately below it, AutoComplete will fill in the letters 'ohn' completing the word 
John. You simply need to press Enter to accept the substitution. If you have two words with the 
same first letter in a column of adjacent cells, John and Jack for example, and you type a J, 
AutoComplete will wait until you type a second letter to discern the most likely match to 
complete the entry.  
 

 
 

Deleting and replacing data 
To clear cell content: 

� Select a single cell or range of cells and press the Delete key; or 
� Right-click on the cell and select the Clear Contents option 

 
To replace the contents of a cell: 

� Select the cell and begin typing - or 
� Use Find and Replace to make the same replacement multiple times  

(On the Home Ribbon – Editing group – Find and Select button - Replace or Ctrl + H)  
 
 
Try it: On Sheet 2 of Sales report.xlsx, select and delete the days of the week and months of 
the year entered in using the Fill handle. 
On Sheet 2 of Sales report.xlsx, replace 60000 in cell B5 with 62000. 
Switch to Sheet 1. Use Find and Replace to replace the word Difference with Over/under target. 
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Using Formulas in Excel 
Formulas are used to perform calculations in a spreadsheet, including addition, subtraction, 
multiplication and division. 
 
The main advantage of using formulas is that unlike a value that stays the same unless you edit 
it, the result of a formula will automatically recalculate itself in response to values in the 
spreadsheet being changed. 
 
Formulas can be easily recognised in a spreadsheet as all formulas begin with an 
equals sign =. 
 

Basic Mathematical Operators 
To build formulas in Excel, you will have to use the basic mathematical operators as shown in 
the following table. 
 
 
 
 
 
 
 
 
Try it 
In Sheet 1 of the Sales report.xlsx file, enter a formula in cell D5 to calculate the difference 
between Sandra’s actual sales and her target for Quarter 1. The formula is =B5-C5. 
 
Create formulas to calculate the difference between Sandra’s actual and target sales for 
Quarters 2 and 3 in cells G5 and J5 respectively. 
 
Create formulas to calculate the difference between the remaining sales peoples’ actual and 
target sales for Quarters 1, 2 and 3. 
 
In cell K5, create a formula to calculate Sandra’s ‘eligible for commission’ total. This is achieved 
by adding together any positive differences between her actual and target sales for each 
quarter. In other words, any quarter where Sandra exceeds her target sales, the amount that 
she exceeded her target by is eligible for commission. 
 
Calculate ‘eligible for commission’ totals for the other two salespeople in K6 and K7. 
 
In cell L5, create a formula to calculate the amount of commission Sandra is to be paid. 
The formula is =K5*L2. 

( ) Brackets ^ Exponent 

+ Addition * Multiplication 

- Subtraction / Division 
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Order of calculations – BEDMAS or BODMAS 
In formulas where there is more than one operator, for example, an addition and a 
multiplication, Excel will not necessarily calculate the result by reading the formula from left to 
right. 
 
Excel will follow a set rule for the order in which it performs calculations. BEDMAS or BODMAS 
are acronyms you can use to help you remember the order in which Excel will perform 
calculations. 
 

Letter Stands for Calculation 
order 

B Brackets 1
st
 

E or O Exponents or Order 2
nd

 

D Division 
3

rd
 

M Multiplication 

A Addition 
4

th
 

S Subtraction 

 
 
Try it: Apply the order of calculation rule to the formulas shown below and write in the result of 
the formula in the space provided. 
 

Formula Formula result would be: 
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Saving a Workbook 
One way to save an Excel Workbook is to choose the Save As option from the Excel 2010 
Office menu.  
 
 

 

Another way to save your workbook is to click the Save button  on the Quick Access 
toolbar. 
 
You can also use the shortcut keys Ctrl + S 
 

About Excel File Types 
Excel 2010 and Excel 2007 use the same file types which are different from the file types of 
previous versions of Excel. You should have no problems using Excel 2010 to open and work 
with files created with earlier versions of Excel. If you find that you can’t use Excel 2010 files 
with earlier versions of Office, like Office XP or Office 2003, you may require a software patch 
available from Microsoft Office Online or Microsoft Update.  
 
When you are saving a workbook file with Excel 2010, you can specify Excel 97-2003 
Workbook as the file type by using the Save As type drop list in the Save As dialogue box. This 
can be helpful if you are worried about compatibility with earlier versions of Microsoft Office.  
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Unit 2 Practice Activity 
 
1. Create a new workbook. 

2. Enter data as shown in Example 1 below. 

3. In cell E5, enter the formulas to calculate the total costs for each item. 
Hint: multiply the cost per item by the quantity required. 

4. Use Undo to remove the formula you entered in E5, and then use Redo re-enter it. 

5. Save the workbook as Practice total costs. 

6. Compare the workbook to Example 2 below. 

7. Close the workbook. 

 

 
Example 1 
 

 
Example 2 – formulas for Total cost are shown on the right 
 
 
 

Online support forum and knowledge base 
www.microsofttraining.net/forum 
Visit our forum to have your questions answered by our Microsoft certified trainers. 
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Unit 3: Modifying a Worksheet 
 
In this section you will learn how to: 
 

� Move and copy data 
� Move and copy formula 
� Identify relative and absolute references in a formula 
� Create an absolute reference in a formula 
� Inserting and deleting ranges 
� Use Smart Tag options 

 
 

Moving and Copying Data 
Moving involves physically transferring data from one location to another, whereas copying 
refers to duplicating data so that it appears in more than one location. 
 
There are several methods that can be used to move or copy data. 

Dragging and Dropping Cells 
To move data from one cell to another using your mouse: 

� Select a cell by clicking on it, making it the active cell. 
� When you see the thick black border around the cell, move your mouse pointer over 

one edge of the border. You will see your pointer turn into a four-headed arrow. 
 

 
 

� Hold your left mouse button down and drag the cell contents to a new location. 
 

 
If you select a group of cells, the selection will be surrounded by a thick black border. You can 
mouse drag a selection by grabbing this border, just as you dragged a single cell. 
 
Try it: Switch to Sheet 3 of Sales report.xlsx, use the mouse to move the values in cells C5:C7 
to C8:C10. Then use Undo to reverse this action. 
 

How to Cut, Copy, and Paste Cells 
 
By right-mouse click: 

� Select the data, then right-click for cut and copy options 

� Select the destination cell for the data, then right-click for the paste option 

 
Try it: On Sheet 3 in Sales report.xlsx, move the names that appear in cells A5:A7 to cells 
A8:A10. 
Then use Undo to move the names back to their previous location. 
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Using the Clipboard group 
The clipboard button group is at the far left of the Home Ribbon.  

 
This group of buttons relates to the tasks of cutting, copying, and 
pasting items from one location to another. The clipboard is the 
place where copied items are stored until they are needed.  
 
 

Paste Buttons 
 

 

The Paste button will paste the most recently cut or copied item from the 
clipboard to the location starting at the active cell. Items on the clipboard 
can be text, numbers, cell selections, and more. The clipboard can store up 
to 24 copied items. (Shortcut key: Ctrl + V) 
 
The bottom paste button (with the small down pointing arrow) will display a 
menu of paste options when clicked. 

Cut Button 
 

 

This button will remove the selected item from its original location and place 
it on the clipboard for future use. (Shortcut key: Ctrl + X) 

Copy Button 
 

 

This button will copy a selection or other item from the spreadsheet to the 
clipboard. Unlike cut, copy will not remove the selection or item from its 
original location in the spreadsheet. (Shortcut key: Ctrl + C) 

 
When you cut or copy items, they are saved to the clipboard.  
You can view the items on your clipboard at any time by clicking the Home 
tab to display the Home Ribbon, and then clicking the small arrow at the 
bottom right of the clipboard button. 

 

 
 
You can clear all the items from the office clipboard by clicking the Clear All button, or you can 
paste all of the items on the clipboard by using the Paste All button. 
 
Try it: Display the Clipboard on your screen. 
On Sheet 3 of Sales report.xlsx, select cells C5:C7 and copy the cells. The values you have 
copied will show on the Clipboard. 
Select cell C8 then click on the copied values showing on the Clipboard. The values should now 
be pasted in cells C8:C10. Use Undo to reverse the Paste action. 
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Moving and copying formulas 
In order to understand what happens when formulas are moved or copied, it is important to 
know about relative cell references and absolute cell references and understand how each type 
of reference behaves in a formula when moved or copied. 

Relative cell references 
In Excel, a specific cell can be named or referred to with a cell reference. A simple cell 
reference is just the letter at the top of the cell’s column, paired with the number at the left of the 
cell’s row. Cell A1, for example, is the first cell in the top left corner of the Excel grid (first 
column letter, A, and first row number, 1). 
 

 
 
In the image above, Cell A2 contains the value 500 while cell B2 contains the value 250. Cell 
C2 contains a formula (=A2+B2, visible in the formula bar) that adds these two numbers by 
using their respective cell references. 
 
If you use your mouse to drag the cell containing the formula (C2) down to fill part of the column 
(using the Fill handle), you will see zeros in the cells that you drag the formula to. 
 

 
 
You should also notice that the formula for cell C8 (the active cell) can be read from the formula 
bar as =A8+B8. But remember, the original formula in C2 (the cell we filled from) was =A2+B2. 
The formula has changed to reflect the relative positions of the cells. The formula in cell C2 
adds the two cells to its immediate left. Each cell that this formula has been filled to, will contain 
a formula that adds the two cells to its immediate left. 
 
In other words, the formula adopts cell references that are relative to its position in the 
worksheet. This maintains the same relative positioning of the original formula. This results in 
zeros in the locations where the cells to the immediate left of the formula are empty.  
 
This is called a relative cell reference, meaning that if the formula is copied (dragged, filled, or 
copied) the cells involved will change to reflect the formula’s new position. 
 
 
Try it: On Sheet 1 of Sales report.xlsx, delete the formulas in cells G5 and J5. Copy the formula 
in cell D5 into cells G5 and J5. Note how the result of the formula changes when it is pasted 
into these two cells. 
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On Sheet 1 of Sales report.xlsx use the Fill handle to copy down the formulas created in 
D5, G5, J5 and L5 to the next two rows (rows 6 and 7). 
 
Why do you get incorrect formula results appearing in cells L6 and L7? Discuss with your 
trainer. 
 

Absolute cell references 
In the example below, we have mouse dragged a formula with absolute references to fill the six 
cells beneath it. 

 
 

Notice that this time, the value of 750 is in each cell, and the formula contained in the active 
cell, C8, contains dollar signs. These dollar signs tell Excel that the references in the cell are 
absolute: no matter where the formula is copied or filled to, it will always use the same cell 
references.  
 
The original formula at cell C2 is =$A$2+$B$2. When this formula is copied or dragged or filled 
anywhere on the worksheet, the formula will retain the same cell references because they are 
marked with dollar signs. 
 
You can create an absolute reference by pressing the F4 key once, immediately after the cell 
reference has been entered into the formula. 
 
Try it: On Sheet 1 of Sales report.xlsx select cell L5. 
 
Change cell L2 in the formula into an absolute reference. This can be done by clicking next to 
L2 in the formula and pressing the F4 key once so the formula reads =K5*$L$2. 
 
Then use the Fill handle to copy the new formula down to cells L6 and L7. The correct formula 
results should now display. 
 
Use Ctrl + the ‘pipe’ key to display formulas and show the absolute reference in the formula in 
column L. 
 
Save the changes made to Sales report.xlsx. 
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Inserting and Deleting Ranges 
Quite often once you have created a spreadsheet you will want to modify it by adding or 
deleting rows or columns of data. 

Inserting columns and rows 
To insert a column in a worksheet: 

� Right-click on the letter at the top of the column. A drop down menu will be displayed. 
 

 
 

� Click the Insert option from the menu. A new column is inserted to the left of the 
selected column. 

 
 
This procedure is essentially the same for inserting rows. To insert a row, just right-click on the 
row number and choose Insert from the menu. A new row is inserted above the selected row. 

Deleting columns and rows 
To delete a column, right-click on the letter at the top of the column and choose 'Delete' from 
the drop-down menu. 
 
To delete a row, right-click on the number at the left of the row, and choose 'Delete' from the 
drop-down menu. 
 
 
The Cells group on the Home Ribbon also gives you control over inserting and deleting a cell or 
group of cells. 
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Try it: On Sheet 1 of Sales report.xlsx, delete Pam’s information (row 6) from the spreadsheet, 
and then use Undo to bring it back. 
 
Insert three rows above the Totals row (row 8) at the bottom of the spreadsheet. These rows 
will display the data related to the three salespeople on Sheet 3 of Sales report.xlsx. 
 
Move the data for the three salespeople on Sheet 3 into the appropriate positions in the three 
newly created rows in Sheet 1. 
 
Use the Fill handle to copy down the formulas in columns D, G, and J. 
 
Calculate the ‘eligible for commission’ Total for each salespeople in column K. 
 
Use the Fill handle to copy down the formula in column L. 
 
Save the changes made to Sales report.xlsx. 
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Unit 3 Practice Activity 
 
1. Open Practice sales summary.xlsx. 

2. Delete the row containing the 2002 figures (row 3). 

3. Insert a new row between rows 1 and 2. Enter the heading Sales 2003-2007 into cell A2. 

4. Enter a formula to calculate the total sales for 2003 in F4. 

5. Use the AutoFill handle to copy the year total formula from F4 to F7. 

6. In B8, enter formula that will calculate predicted sales for each quarter in 2007. 
For 2007, sales in each quarter are predicted to increase by 2% (on average) from same 
quarter in the previous year. Note that 2% has been entered into cell E10 to be used as part 
of the formula. 

7. Copy the formula in B8 to C8 through to E8. Check your formula results in C8:E8 – if the 
quarterly results are the same as those in the previous year then the formula in B8 needs 
correcting. 

8. Change the percentage in E10 from 2% to 1.5%. The predicted sales for 2007 should 
automatically recalculate once the percentage has been altered. 

9. Copy the formula from F7 down to F8, so total predicted sales for 2007 show in the 
spreadsheet. 

10. Save the workbook as My practice sales summary and close the workbook. 

 
 

Online support forum and knowledge base 
www.microsofttraining.net/forum 
Visit our forum to have your questions answered by our Microsoft certified trainers. 
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Unit 4: Using Functions 
 
In this section you will learn how to: 
 

� Identify common functions 
� Insert a function into a formula 
� Use the SUM, AVERAGE, MAX, MIN and COUNT functions 

 
 

What are Functions? 
In Excel, a function can be described as a built in tool for performing mathematical or logical 
tests. Quite often, you may need to perform operations in your worksheets that involve many 
cells, like totaling a lengthy column of numbers or averaging a large group of data. Excel’s 
functions can help you with these tasks. 
 
Excel 2010 has a wide range of functions. For example, you can use functions to find totals, 
averages, counts, minimum (smallest) and maximum (highest) amounts.  
 

SUM  Calculates the sum for a range of cells. 

AVERAGE   Returns the average for a range of numbers. 

MAX  Returns the largest number from a range of numbers. 

MIN Finds the minimum number in a range of numbers. 

COUNT   Will count the number of cells in a list that contain numbers. 
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Using AutoSum 
It is often useful to have totals or sums for the rows and columns of numbers in your worksheet. 
AutoSum can easily add all of the numerical data in a column or row.  
 

� Select the cell immediately below the column of data (or immediately beside the row of 
data) 

� Click the Formulas tab 
� Click AutoSum* button in the Function Library group. 

 
� The column or row of data to be summed will now be enhanced by an animated border. 

Notice that you can see the range to be summed in the active cell. 

 
� Press Enter and the total will be displayed in the cell. 

 
Try it: On Sheet 1 of Sales report.xlsx use the AutoSum button to calculate Total actual and 
target sales for each quarter in row 11. 
 
* The AutoSum button can also be found on the 'Home' ribbon in the 'Editing' group 
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The Function Library 
Excel 2010 contains an extensive library of functions that you can call upon to help you solve 
problems. These tools are available in the Function Library button group, on the Formulas 
ribbon.  

 
 
The first and largest button is Insert Function. This button will open a dialogue box allowing you 
to search for and insert hundreds of functions.  
 
You can also click the small fx button next to the formula bar to display the Insert Function box. 

 
 
 
Clicking the Insert Function button activates the Insert Function dialogue box and provides 
access to the large range of functions available in Excel. 

 
 
Once the Insert Function dialogue box is open: 

� Select the function you wish to use from the available list and click OK or 
� Type the name of the function you wish to use in the Search for a function area, press 

Enter, select the function when it appears in the list and click OK. 
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In the Function Arguments dialogue box, click the top button with the red arrow, then select the 
range of cells to enter into the formula from the spreadsheet, click OK. 
 

 
Try it: On Sheet 1 of Sales report.xlsx type Average into cell A12.  
Use the Insert Function button to calculate average actual and target sales for each quarter in 
row 12. 
 

Using the AutoSum dropdown list 
The AutoSum button dropdown arrow provides access to common functions, and the Insert 
Function dialogue box. 

 
 
To insert a function using the AutoSum list: 

� Select the cell where the formula is to appear in the spreadsheet 
� Select the function you wish to use from the AutoSum list 
� Check the formula to ensure it is accurate – edit the formula if necessary 
� Press Enter to confirm the formula and display the formula result. 

 
Try it: On Sheet 1 of Sales report.xlsx type Minimum into cell A13.  
Use the AutoSum list to calculate minimum actual and target sales for each quarter in row 13. 
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Entering functions manually 
All the common functions follow the same basic structure: 
=function_name(cell:cell) or =function_name(cell,cell,cell) 
 
Therefore, formulas containing functions can be typed directly into a cell in the spreadsheet. 
After pressing the = (equals button) start typing a function name. Immediately after entering the 
first character of the name, Excel provides you with a list of function names beginning with that 
letter. Locate the function name you require and double click on it. Excel will then insert the 
name together with the opening bracket. All you then have to do is to complete the function 
requirements and press enter. The closing bracket is automatically inserted for you and the 
result of the formula is entered into the selected cell. 
 
Try it: On Sheet 1 of Sales report.xlsx type Maximum into cell A14.  
Enter formulas to calculate maximum actual and target sales for each quarter into row 14. 
 
Type No. of employees into cell A15. 
 
Use any one of the three methods for inserting functions to enter the COUNT function into cell 
B15. The COUNT function can be used on cells that contain values, to determine how many 
values there are. In this case, we want to know how many employees there are. 

Using AutoCalc 
The AutoCalc feature in the status bar at the bottom-right of the Excel window can be used to 
find the result of using particular functions on cells that have been selected in the spreadsheet. 

 
 
To use the AutoCalc feature: 

� Select the range of values that you wish 
to find the 
total/average/minimum/maximum/count 
of 

� Right-click in the status bar and choose 
the relevant function(s) from the menu to 
view the result in the status bar area. 
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Unit 4 Practice Activity 
 
1. Open My Practice sales summary.xlsx.  This is the file you worked on for the Unit 3 

Practice Activity. 

2. Enter the labels Average, Minimum and Maximum into cells G3, H3 and I3 respectively. 

3. In cell G4, enter a function to calculate the average quarterly sales for 2003. Copy the 
formula down to row 8. 

4. In cell H4, enter a function to calculate the lowest quarterly sales value for 2003. Copy the 
formula down to row 8. 

5. In cell I4, enter a function to calculate the highest quarterly sales value for 2003. Copy the 
formula down to row 8. 

6. Save the changes made to My Practice sales summary and close the file. 

 
 

Online support forum and knowledge base 
www.microsofttraining.net/forum 
Visit our forum to have your questions answered by our Microsoft certified trainers. 
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Unit 5: Formatting Worksheets 
 
In this section you will learn how to: 
 

� Apply font formats to a worksheet 
� Alter alignment 
� Apply number formats to a worksheet 
� Add patterns and colour to a worksheet 
� Add borders to a worksheet 
� Change column width and row height 

 
 

The Home Ribbon 
Common formatting features can be found in the Font, Alignment, Number, Styles and Cells 
groups on the Home Ribbon (below). 
 
 

Font 
 
The font button group lies on the Home Ribbon next to the clipboard group. 
 

 
 
These buttons allow you to change a font’s type, size, color, and style. The following table 
provides a brief description of the functions of these buttons 
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The Font Face 
Button 
 

 

This button allows you to change the type of font. Clicking the small 
down pointing arrow will allow you to select from a large list of available 
fonts. The scroll bar at the side of the font list will allow you to view all of 
the fonts available. 

 

  

The Font Size 
Button 
 

 

Use this button and its associated list of sizes to change the font size. 
You can also enter a size directly by clicking on the area that displays 
the current size and then entering a new number. 

  

Increase And 
Decrease Font 
Size Buttons 
 

 

These buttons will increase and decrease the font size of a selected cell 
or cells by increments of one from size 8 to 12 and thereafter in 
increments of 2. 

  

Bold, Italic, and 
Underline Buttons 
 

 

These buttons will apply bold, italicized, or underlined effects to a cell or 
selection of cells. 

  

Borders 
 

 

Clicking the small arrow on this button will display a list of borders that 
you can apply to a cell or selection of cells. 
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Fill Color and 
Font Color 
 

 

The fill color button (paint bucket) will fill the background of a cell or 
selection of cells with the specified color. The arrow next to the button 
displays a palette of color options. 
 
The font color button (letter A) will color the text in a cell or selection of 
cells with the color that is specified. The arrow will display a palette of 
color options. 

   

Font Group 
Button 

Clicking the small arrow at the right of this button will display the font tab 
of the Format Cells dialogue box, which provides numerous options 
related to cell formatting. 

 
Try it: Format the headings in rows 1 and 2 on Sheet 1 of Sales report.xlsx, using font formats 
of your choice. 
 
 

Alignment 
The buttons in the alignment group control how data (text or numbers) appears in spreadsheet 
cells. 

 
 
The following table provides brief descriptions of the alignment buttons. 
 

Horizontal 
Alignment 
 

 

The Align Left button will align the data in a cell or a selection of cells to 
the left edge of the cells. The Align Center button will align cell data in 
the center of the cells. The Align Right button will align cell data to the 
right edge of the cells. 

  

Decrease and 
Increase Indent  
 

 

These buttons will increase or decrease the amount of indent for the 
data in a cell or group of cells. The button with the left pointing arrow 
decreases the indent, while the button with the right pointing arrow 
increases the indent.  

  

Vertical 
Alignment 
 

 

These buttons align your data relative to the top, middle, and bottom of 
the cells.  

  

Text Orientation 
 

 

This button will rotate the text in a cell to various positions. 
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Wrap Text 
 

 

If there is too much data for the length of a cell, the wrap text button will 
display the data on multiple lines so that it is visible. 

Merge and Center  
 

 

This button will merge multiple selected (empty) cells into one larger 
cell. Data in the new large cell will be centered. 
 

Alignment Group  
 

 

Clicking the small arrow on this button will display the alignment tab of 
the Format Cells dialogue box. 

 
Try it: Use Merge and Center to centre the headings in row 1 and in row 2 across the top of the 
spreadsheet. Use Merge and Center to centre the quarter labels in row 3 across the columns of 
figures relating to each particular quarter. 
 

Number 
The number button group controls how numerical values are displayed in 
cells. In Excel, numbers can have different formats including general (no 
specific format), number, currency, accounting, short date, long date, time, 
percentage, fraction, scientific and text. 
 
Let’s take a look at each command in this group. 
 

Number Format List 

 
 

Use this list to choose what format will be applied to a cell or selection 
of cells.  
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Currency, Percent, 
and Comma  
 

 

Use these buttons to select a type of currency, a percent, or a comma 
separated number format for a cell or group of cells. 
 

Increase/Decrease 
Decimal Places 
 

 

These buttons will increase or decrease the amount of decimal places 
shown for a cell or selection of cells. 

Number Group  
 

Clicking the small arrow at the right of this button will display the 
Number tab of the Format Cells dialogue box. 

 
Try it: Format all values and formula results in the spreadsheet to show commas between the 
hundreds and thousands values and zero decimal places. Add currency symbols to the totals, 
average, minimum and maximum figures. 

Format Painter 

 
The Format Painter button on the Clipboard group will copy a specific format from one area, 
which can than be applied to another area. For example, you can select a group of cells and 
then click the format painter button to copy their format. You will then see a small paint brush 
next to your mouse pointer. When you select another different group of cells, the copied format 
will be applied (painted) to them. 
 
If you wish to apply the same formatting to different sections of your spreadsheet using Format 
Painter, then you must first select the formatted cell/s, double-click the button and then click on 
whichever cells require changing. When you have finished, clicking the Format Painter button or 
pressing the Escape key will release Format Painter. 
 
Try it: Use Format Painter to copy the formatting applied to the heading in row 1 on Sheet 1 
and apply formatting to the heading in row 1 on Sheet 2. 
 
 

Changing the Size of Rows or Columns 
To change the size of a column, place your mouse pointer on the line that divides the column 
letters at the top of the column you want to change. For example, if you wanted to change the 
size of column B, you would place your mouse pointer on the line separating B and C. Your 
mouse pointer will turn into a vertical line with a small arrow on either side. 

 
When you see this pointer you can change the column size by holding the left mouse button 
and dragging the column edge to the left or right. Also, when your cursor is in this position, 
double-clicking will automatically change the column width to match whichever cell contains the 
most data. 
 
To change the size of a row, place your pointer on the line separating the row numbers at the 
left of the worksheet. When you see the pointer with a vertical line and an arrow on either side, 
drag the edge of the row to change the size.  
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Unit 5 Practice Activity 
 
1. Open My Practice sales summary.xlsx. 

2. Format all the quarterly values for all years to show a comma separator between the 
thousands and hundreds digits, with no decimal places. 

3. Format the totals, average, minimum and maximum sales for each year to show currency 
symbols and a comma separator between the thousands and hundreds digits. 

4. Change the font size for the heading in row 2 to 12pt. 

5. Use the Merge and Center feature to centre the headings in row 1 and row 2. 

6. Apply bolding and a top and bottom border to the labels in row 3. 

7. Left-align the years in cells A4:A8. 

8. Apply a bottom border to cells A8:I8. 

9. Save the changes made to My Practice sales summary and close the file. 

 
 

Online support forum and knowledge base 
www.microsofttraining.net/forum 
Visit our forum to have your questions answered by our Microsoft certified trainers. 
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Unit 6: Printing Workbooks 
 
In this section you will learn how to: 
 

� Use Print preview 
� Use the Print dialogue 
� Use the Page Setup dialogue 
� Use Quick Print 

 
 

Working with Print Preview 
Print Preview allows you to view how your spreadsheet will look when it prints, before printing it 
off. 

Opening Print Preview 
To open Excel 2010’s Print Preview screen, either click the 'Print Preview' button on your Quick 
Access Toolbar or click the 'File' menu and click the 'Print' section in the Backstage area. This 
will display the Print button, Printer selection button and a Settings area. 
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From the 'Settings' area you can choose the following settings: 
 

What to Print 

 

Pages to Print 

 

Collated Style 

 

Paper Orientation 

 

Paper Size 

 
 

Margins 
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Scaling 

 

 

 

Using Page Setup 
Here’s what the Page Setup dialogue looks like. 
 

 
 

The Page tab 
Under the Page tab, you can change page orientation (portrait or landscape), print scale, paper 
size and print quality settings. 
 
Try it: Change the page orientation for Sheet 1 of Sales report.xlsx to Landscape. Use Print 
Preview to view the change to page orientation. 
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The Margins tab 
Under the Margins tab, you can specify how to centre your page (horizontally or vertically) and 
you can directly enter values for the margins in the fields provided. 
 
Try it: Change the left and right margin measurements to 0.5. Use Print Preview to observe the 
margin changes. 
 

The Header/Footer tab 
Under the Header/Footer tab, you can choose headers and footers that will be visible on the 
top (header) and bottom (footer) of each printed page. You can select preset headers and 
footers by clicking on them in drop lists located beneath the header, and above the footer, 
preview fields. 
 

 
 

If you click the Custom Header or Custom Footer buttons, you will see a dialogue box like the 
one shown below. 
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You can use this box to design a custom header by entering text in the provided fields. You can 
also format the text and enter page numbers, dates, and times by using the buttons above the 
text fields. 
 
Try it: Choose the Sales report.xlsx, Page 1 option from the preset options for the footer. 
Use Custom Footer to add your name to the footer as well. 
View the changes in Print Preview. 
Use Custom Footer to remove your name from the footer area. 
 
 

The Sheet tab 
Under the Sheet tab you will find a control that will let you define a Print Area (a selection of 
cells from your workbook). If you define a Print Area, this is what Excel will print by default from 
the sheet if the Print button is clicked. 
 
Try it: Set a print area that contains the cell range A1:J11 on Sheet 1 of Sales report.xlsx. 
Then clear the print area. 
 
 

Printing options 
In Excel 2010, you have the option to produce hard copies of your spreadsheet with or without 
changing print settings prior to printing. 
 

Quick Printing 
If you click the Quick Print item on the Quick Access Toolbar, you will immediately send your 
workbook to the default printer, with no special formatting or page setup. 
 
Quick printing is also quite appropriate for small selections or ranges from a larger spreadsheet. 
You can select a print region (a selection of cells) by dragging your mouse and then click Quick 
Print. When you do this, only the region you selected will be printed. 
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Unit 6 Practice Activity 
 
1. Open My Practice sales summary.xlsx. 

2. Preview the worksheet. 

3. Change the page orientation to Landscape. 

4. Centre the sheet horizontally. 

5. Create a custom header.  In the left section, enter Time Out Holidays.  In the right section 
enter the date. 

6. Preview the worksheet to preview the changes you have made. 

7. Close out of Print Preview. 

8. Set the cell range A1:E7 as the print area. 

9. Preview the worksheet to check the print area has been set correctly. 

10. Close out of Print Preview. 

11. Clear the print area. 

12. Save the changes made to My Practice sales summary, and close the file. 

 
 

Online support forum and knowledge base 
www.microsofttraining.net/forum 
Visit our forum to have your questions answered by our Microsoft certified trainers. 
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Unit 7: Working With Charts 
 
In this section you will learn how to: 
 

� Create a chart in Excel 
� Modify a chart 
� Enhance a chart using various chart formatting features 

 

Creating a Chart 
Excel 2010 provides a series of chart buttons and controls on the Insert Ribbon. 

 
 
Before you create a chart, first consider the type of chart that you require. Pie charts and bar 
charts are good for showing comparisons. Line graphs can be useful for showing trends and 
plotting relationships between variables. If you want a really visually interesting chart, consider 
a three dimensional type.  
 
To create a chart: 

� Select the data that you want to base your chart on. 
� Select the Insert tab to display the Insert Ribbon. 
� On the Insert Ribbon, click the relevant chart type button to show a menu of various 

ways to display your chart. 
 

 
 

Try it: Select the cell ranges A4:A10 and H4:I10 from Sheet 1 of Sales report.xlsx. 
Hold down the Ctrl key while using your mouse to select non-adjacent ranges of cells from a 
spreadsheet. Create a 3D clustered column chart from your selected data. 
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Manipulating a Chart 
Once the chart has been created, there are a number of ways in which it can be manipulated. 

Moving and resizing a chart 
Sometimes it may be necessary to resize or even move your chart around in your spreadsheet. 
To do this, first single click in the chart area to display the chart area border. 
 

 
 
If you place your mouse pointer on the corner of the chart border and let it hover, you will see 
your pointer turn into a double headed arrow. If you drag the chart corner with your mouse, you 
can resize the chart.  
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To move the chart, let your mouse pointer hover over any border. When you see your mouse 
pointer turn into a cross with four arrows, you will be able to move the chart around your screen 
by holding the left mouse button down and dragging. 
 

 
 
Try it: Move the column chart underneath the spreadsheet data and make it larger. 
 
If you want to make a chart an object in another worksheet, or move the chart to a sheet of its 
own, do the following. 
 

� Right-click on the chart 
� Choose Move Chart from the drop down menu 
� Select New Sheet or a different sheet from the Object in: dropdown arrow 
� Click OK 

 
 

Try it: Move the chart to a new sheet; then move the chart back to Sheet 1. 
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Note that you can also click the Move Chart button in the Design Ribbon to display the Move 
Chart dialogue box. 

 

 
 
 
To remove a chart from your worksheet: 

� Click in the chart area 
� Press the Backspace or Delete key on your keyboard. 

Adding a chart title 
To add a chart title: 

� Click in the chart area to display the Chart Tools contextual tab 
� Select the Layout tab 
� Click the Chart Title button and select an option that will allow you to add a title 
� Right-click on the Chart Title area that appears within the chart area 
� Choose Edit Text and enter your chart title 

 

 

 

Adding chart axis titles 
To add chart axis titles: 

� Click in the chart area to display the Chart Tools contextual tab 
� Select the Layout tab 
� Click the Axis Title button and select an option that will allow you to add an axis title 
� Right-click on the Axis Title area that appears within the chart area 
� Choose Edit Text and enter your axis title 

 
Try it: Add a chart title and axis titles to your chart. 
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Changing the Type of Chart 
To change the chart type: 

� Click in the chart area to display the Chart Tools contextual tab 
� Select the Design tab 
� Click the Change Chart Type button 
� Select the new chart type and click OK or 

 
� Right-click on the chart area and selecting Change Chart Type from the drop down 

menu that appears. 
 
 

 
 

 
You can also display the Change Chart Type dialogue box by right-clicking the Plot area 
 
Try it: Change the chart into a bar chart, then back to a column chart. 
 

Formatting a Chart 
Even after you create a chart, you can still alter its appearance. You can change how a chart 
looks by: 

� Selecting the chart area and selecting the Design tab or 
� Selecting an object in the chart area then right-click and select Format [Object name] 

from the menu 
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Unit 7 Practice Activity 
 
1. Open My Practice sales summary.xlsx. 

2. Create a column chart in its own sheet based on the quarterly sales for the years 2003 to 
2006.  Do not include the yearly totals, averages, minimum or maximum figures. 

3. Add a chart title. 

4. Change the colour of the chart bars. 

5. Move the legend so it is positioned underneath the chart. 

6. Save the changes made to My Practice sales summary and close. 

 
 
 

Online support forum and knowledge base 
www.microsofttraining.net/forum 
Visit our forum to have your questions answered by our Microsoft certified trainers. 
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Unit 8: Working With Sparklines 
 
In this section you will learn how to: 
 

� Create a Sparkline in Excel 
� Modify Sparklines 
� Format Sparklines 

 

What are Sparklines? 
 
New in Microsoft Excel 2010, a sparkline is a tiny chart in a worksheet cell that provides a visual 
representation of data. Use sparklines to show trends in a series of values, such as seasonal 
increases or decreases, economic cycles, or to highlight maximum and minimum values. 
Position a sparkline near its data for greatest impact. 
 
Sparklines help bring meaning and context to numbers being reported and, unlike a chart, are 
meant to be embedded into what they are describing: 

 

In the above example, the sales number alone gives you a single moment in time, but adding 
sparklines in the table, next to the numbers it’s describing, gives history and shows a pattern of 
sales. The sparklines aren’t floating on the grid of Excel like a chart does. They aren’t rows, 
column, or sheets away from the data. They are in the table giving context to the numbers, 
unobtrusively, and appear like text in the cell. 
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Create a Sparkline 

1. Select an empty cell or group of empty cells in which you want to insert one or more 

sparklines. 

2. On the Insert tab, in the Sparklines group, click the type of sparkline that you want to 

create: Line, Column, or Win/Loss. 

 

3. In the Data box, type the range of the cells that contain the data on which you want to 

base the sparklines. 

Note You can click to temporarily collapse the dialog box, select the range of cells 

that you want on the worksheet, and then click to restore the dialog box to its 

normal size. 

Modify a Sparkline 

When one or more sparklines are selected, the Sparkline Tools appear, displaying the Design 

tab. On the Design tab, you can choose one or more of several commands from among the 

following groups: Sparkline, Type, Show/Hide, Style, and Group. Use these commands to 

create a new sparkline, change its type, format it, show or hide data points on a line sparkline, 

or format the vertical axis in a sparkline group. 

Use the Style gallery on Design tab, which becomes available when you select a cell that 

contains a sparkline. 

1. Select a single sparkline or a sparkline group. 

2. To apply a predefined style, on the Design tab, in the Style group, click a style or click the 

arrow at the lower right corner of the box to see additional styles. 

 

3. To apply specific formatting to a sparkline, use the Sparkline Color or the Marker Color 

commands. 
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Customize sparklines 

After you create sparklines, you can control which value points are shown (such as the high, 

low, first, last, or any negative values), change the type of the sparkline (Line, Column, or 

Win/Loss), apply styles from a gallery or set individual formatting options, set options on the 

vertical axis, and control how empty or zero values are shown in the sparkline. 

Control Which Value Points Are Shown 

You can highlight individual data markers (values) in a line sparkline by making some or all of 

the markers visible. 

 

In this sparkline, the high value marker is green, and the low value marker is orange. All other 

markers are shown in black. 

• To show all values, select the Markers check box. 

• To show negative values, select the Negative Points check box. 

• To show the highest or the lowest values, select the High Point or Low Point check 

boxes. 

• To show the first or the last values, select the First Point or Last Point check boxes. 

Show or hide data markers 

On a sparkline that has the Line style, you can show data markers so that you can highlight 

individual values. 

1. Select a sparkline. 

2. In the Show/Hide group, on the Design tab, select any of the check boxes to show 

individual markers (such as high, low, negative, first, or last), or select the Markers check 

box to show all markers. 

Clearing a check box hides the specified marker or markers. 
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Show and customize axis settings 

You can select Date Axis Type (in the 'Group' group, click Axis) to format the shape of the 

chart in a sparkline to reflect any irregular time periods in the underlying data. 

 

In a line sparkline, applying the Date Axis type can change the slope of a plotted line and the 

position of its data points in relation to each other. 

In a column sparkline, applying the Data Axis type can change the width of and increase or 

decrease the distance between the columns, as shown in the following image. 

 

In the example shown here, there are two column sparklines that use data from the same 

range. The sparkline with the “Trend” label uses the General Axis type, and the sparkline with 

the “Trend (Data Axis Type)” label uses the Date Axis type. In each sparkline, the first two data 

points are separated by two months, and the second and third are separated by seven months. 

By applying the Date Axis type, the space between the three columns changes proportionally to 

reflect the irregular time periods. 

You can also use these Axis options to set minimum and maximum values for the vertical axis 

of a sparkline or sparkline group. Setting these values explicitly helps you control the scale so 

that the relationship between values is shown in a more meaningful way. 

1. With the sparkline or sparkline group selected, in the 'Group' group, click Axis. 

2. Under Vertical Axis Minimum Value Options or Vertical Axis Minimum Value 

Options, click Custom Value. 

3. Set minimum or maximum values that you feel will best emphasize the values in the 

sparklines. 

You can increase the height of the row that contains the sparkline to more dramatically 

emphasize the difference in data values if some is very small and some is very large. 
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You can also use the Plot Data Right-to-Left option to change the direction in which data is 

plotted in a sparkline or sparkline group. 

 

If there are negative values in your data, you can emphasize this by showing a horizontal axis 

in your sparkline. 

1. With the sparkline or sparkline group selected, in the 'Group' group, click Axis. 

2. Under Horizontal Axis Options, click Show Axis. 

Any sparklines that contain negative data will display a horizontal axis at 0. 

 

Handle Empty Cells Or Zero Values 

You can control how a sparkline handles empty cells in a range (and thus how the sparkline is 

displayed) by using the Hidden and Empty Cell Settings dialog box. 
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Unit 8 Practice Activity 
 

1. Open Practice Sparklines.xlsx. 

2. Select the Dec 2010 Sales Data worksheet. 

3. Click on cell E8. 

4. Select the Insert ribbon and click the Column button in the Sparklines group. 

5. Click on the  button and select the range B4:M4 in the Annual Sales Data 
worksheet. 

6. Click on the  button and then click OK. 

7. Using the fill handle in the bottom right corner of cell E8 copy the Sparkline down to cell 
E18. 

8. From the Sparkline Tools contextual tab Design ribbon in the Show group, add a 
High and Low point and a First and Last point. 

9. Select a Style from the Style group.  

10. With all Sparkline cells selected modify the type to a Line. 

11. Save the changes made to Practice Sparklines and close. 

 
 
 

Online support forum and knowledge base 
www.microsofttraining.net/forum 
Visit our forum to have your questions answered by our Microsoft certified trainers. 


